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MEMORIA DEL PROJECTE,
SISTEMA D’INFORMACIO DEL PATRIMONI DE SOL DE L'INCASOL.

1. INTRODUCCIO

En el marc del Conveni especific entre I'Institut catala del sol (INCASOL) i la Universitat
Politécnica de Catalunya per a realitzar un sistema d’informacié del patrimoni de sol de
I'INCASOL, el Centre de Politica de Sol i Valoracions, CPSV, ha desenvolupant una aplicacio
informatica d’escriptori que s’ha denominat SIT-Cat 1.0.

L’objectiu del present document és presentar els aspectes basics del projecte i els criteris definits
en el desenvolupament de l'aplicacio. Es presenten els aspectes generals del projecte, els
objectius plantejats en el encarrec del projecte, les bases de treball d’entrada i els criteris de
transformacio de les mateixes, aixi como l'estructura de bases desenvolupada en el sistema, les
consultes i les sortides generades.

Aquest document de “memoria del projecte” pretén ser un document d’explicacié general del
projecte i de I'aplicacié desenvolupada, perd sense explicar els procediments d'utilitzacié de la
mateixa, els que se expliquen en el document “manual d’usuari de suport” ni tampoc presentar
una explicacio6 dels aspectes tecnics del programa, els que es detallen en el “document técnic”.
En el “manual d’usuari de suport” s'explica breument el software utilitzat i les principals
caracteristiques d’aquest. Seguidament es tracta ja I'aplicacié SIT — CAT 1.0 i, concretament, les
funcionalitats basiques de que disposa. Es descriu la interficie grafica d’'usuari i també es fa una
descripcié de les eines basiques de que disposa.

En segon lloc el manual tracta les funcionalitats avangades de I'aplicacié SIT — CAT 1.0, entre les
que destaquen les seleccions per atributs o per localitzacié, les consultes a la base alfanumérica
de les entitats grafiques, el menu contextual de les capes grafiques, la elaboracid de mapes
tematics, les eines incorporades especialment a l'aplicacié, i les eines desenvolupades
especificament per I'aplicacié que han estat agrupades sota el nom “Eines INCASOL". Finalment,
el manual també aprofundeix en la generacio de les sortides d'impressio, tot i que la propia
aplicacio té funcionalitats d’impressio.

El “document técnic recull totes les activitats tecniques que han estat desenvolupades per
materialitzar I'aplicacié SIT — CAT 1.0, aixi com també vol ésser un document explicatiu de la
propia aplicacio.

Es fa la justificacio del software utilitzat amb el que es desenvolupara I'aplicacio, es cita el
procediment d'incorporacié de la cartografia facilitada per INCASOL a I'aplicacio, tant la
importacié6 com les nombroses feines de depuracié que ha suposat la transformacié de la
cartografia en format CAD (arxius DGN de MicroStation majoritariament) al format SIG (arxius o
capes shape que son entesos per qualsevol software SIG).

En tercer lloc el document tracta les activitats de programacié que han estat necessaries per
configurar I'aplicacio a les necessitats de l'usuari, en aquest cas INCASOL. S’explica amb detall
la programacié de les eines INCASOL, nomenclatura que han rebut els procediments que 'usuari
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requeria pel correcte funcionament de laplicacio, aixi com també s’expliquen les eines
addicionals que permetran a l'usuari disposar d’una major potencialitat de I'aplicacio.

Finalment, el document explica l'arquitectura de laplicaci6 SIT — CAT 1.0, és a dir, la
organitzacié de la base de dades que va lligada a les capes grafiques, la composicié dels camps
d’informacié d’aquestes taules alfanumériques i els dominis que s’han generat per cada un dels
camps d'informacié que s’ha cregut convenient.

2. ANTECEDENTS

L’objectiu que es va definir en el encarrec d’elaboraci6 del sintema va ser el de reunir i organitzar
els principals descriptors amb capacitat per identificar els bens de propietat de 'INCASOL,
ubicar-los en un context territorial, (georeferenciar-los), visualitzar les seves caracteristiques
fisiques i geografiques, consultar la situacié “actual” (ortofoto), visualitzar I'existéncia d’ambits
d’actuacio urbanistica, consultar els principals descriptors de potencial urbanistic i contrastar o
superposar informacio de diferents procedencies.

Especificament es tracta de:

1. Dissenyar una base cartografica de terrenys georeferenciats (situats en un sistema de
coordenades geografiques que permeti la correcta visualitzacio dels ens patrimonials d I'lncasol
en el territori i les relacions existents entre ells).

2. Elaborar una base de dades alfanumerica i definir els camps descriptors sintétics del 16 casos.

3. Desenvolupar un servidor de mapes que gestioni les dades des de la base de dades i presenti
les sortides d'informacio.

4. Personalitzar un visualitzador que atengui les consultes més habituals i d’aquesta manera fer
més comode la seva explotacio, consulta i difusié.

5. Aplicar a la mostra de 16 unitats patrimonials de prova i comprovar la funcionalitat del SIG.

Per el desenvolupament es van definir les seglents fases:

Fase 1. Inventari i recopilacié d’informacié que ha de reunir el sistema.
Fase 2. Correccié grafica de la base.

Fase 3. Configuracié i personalitzacié visor.

Fase 4. Carrega de continguts i definicié de consultes.

Fase 5. Sortides i actualitzacid, disseny de sortides i circuit d’actualitzacio.



2.1 SISTEMA D’INFORMACIO GEOGRAFICA

El principi basic d’'un Sistema d’Informacié Geografica (SIG) es que relaciona elements grafics
georeferenciats en el territori amb informacié alfanumerica especifica i que permet vincular
dades, relacionar i operar en un context espacial especific.

La informaci6 del sistema esta georeferenciada i es pot treballar amb informaci6 propia del
sistema, aixi com vincular-se, mitjangant connexions de WMS (Web Map Servers), amb dades
externes, de caracter public generalment d'institucions relacionades amb diferents aspectes de
gestio del territori.

Un SIG és un sistema per la gestid, analisi i visualitzacid de coneixement geografic que
s’estructura en diferents conjunts d’informacié:

- Mapes interactius, que proporcionen una visio interactiva de la informacié geografica que permet
donar resposta a questions concretes i presentar un resultat d’aquestes respostes.

- Dades Geografiques, en la que s'inclou informacio6 vectorial i raster, models digitals del terreny, xarxes
lineals, informacié procedents d’estudis topografics, topologies i atributs.

- Models de Geoprocessament, els quals consisteixen en fluxos de processos que permeten
automatitzar feines que es repeteixen amb frequiéncia (també anomenats rutines), permetent enllagar
uns models amb els altres.

- Models de dades, on la informacié geografica s’estructura en una Geodatabase, la qual és un Gestor
de Bases de Dades (GBD). Incorpora regles de comportament i integritat de la informacié.

- Metadades, les quals descriuen la informacidé geografica, facilitant informacié com el propietari, el
format, el sistema de coordenades, 'extensio, etc., de la propies dades geografiques. Un cataleg de
metadades permet a l'usuari organitzar, realitzar recerques i accedir a informacié geografica
compartida.

2.2 BASES D’ENTRADA DEL TREBALL

2.2.1 Bases grafiques

Les bases grafiques utilitzades per desenvolupar I'aplicacié son per una banda bases de caracter
global d'informacié, de tipus administratiu com la capa de limits de municipis i d'altres
especifiques aconseguides pel CPSV a efectes del projecte amb informacio que afecta a tot el
territori com per exemple PEIN, Vedats de caca i dades de I'Agéncia Catalana del Aigua i
pendents per l'altre les bases especifiques dels bens patrimonials aportades per I'lncasol que
corresponen als ambits d’estudi definits.

Respecte del 16 ambits seleccionats inicialment,es va rebre la informacio grafica dels casos
seglents, que son els que s’han desenvolupat en I'aplicacio.



Patrimoni

| Sant Vinceng de Castellet | Castellgali
Adquisicié
L'Aldea Estacié de mercaderies
Amposta Les Tosses ()
Alguaire Torre del tabac (1)
Sant Joan de les Abadesses Colonia Llaudet
Castellgali Pla del Cami (R-I)
Argentona El cross (R)
Esparraguera Colonia Sedo6 (R)
Arboli (i altres) Castillejos-Mas dén Blai
Riudellots (i altres) Entorn Aeroport
Santa Coloma Cervell6 Colonia Guell
Habitatge
. Badalona . Barri Sant Roc \
Vendes
| Moéra la Nova | Sector 10 |

Les bases s’han rebut en format DGN i el procés de transformacio de les mateixes al format de
treball del sistema s’explica en el “document técnic”.

Pot ser important en aquest punt explicar que el procediment de conversié de la informacio
grafica ha requerit un molt important esfor¢ de depuracid.

A continuacié es presenta un exemple de la cartografia aportada per INCASOL, amb la qual s’ha
desenvolupat I'aplicacio.

Imatge N °1: Planol d’Adquisicié de I'actuacié Entorn Aeroport

Font: Elaboraci6 propia a partir de Microstation V8.



2.2.1 Bases alfanumeériques

S'ha treballat amb els dades aportades per I'Incasol i amb informacié general elaborada pel
CPSV. La informacio de I'lncasol es directe de les actuacions i la informacié generada pel CPSV
es la referida a dades generals del territori.

3. DESENVOLUPAMENT DE L’APLICACIO

3.1 ETAPES DEL TREBALL
Pera la realitzacio del treball s’han definit les seguents etapes o fases:

Fase 1. Inventari i recopilacio d’informaciéo que ha de reunir el sistema, requeriments i
necessitats d’informacio (descriptors). Recopilacié i validacié de la informacio, estructuracié de
BD de les entitats, tematiques i continguts principals.

Fase 2. Correccio grafica de la base, digitalitzacio de noves entitats (Finca, Sector,...),
georeferenciacid, estruqtura relacional, aplicacio a una mostra d'un maxim de vint unitats
patrimonials de 'INCASOL, la llista de les quals s’adjuntara al present conveni.

Fase 3. Configuracié i personalitzacié visor. configuracié del servidor de Mapes adaptat a
estandards OGC, personalitzacié d’un visualitzador d’informacié.

Fase 4. Carrega de continguts i definicié de consultes, realitzacié d'una carrega d'informacid,
generacio de procediments i desenvolupament de criteris de consulta, definicié de consultes
idonies.

Fase 5. Sortides i actualitzacio, disseny de sortides i circuit d’actualitzacid.

Es important explicar en aquest moment que en la proposta del treball no s’havia considerat la
realitzacio de rutines de programaci6 per la generacio6 de les sortides d’informacio, pero degut
a que moltes de les qiestions referides a les consultes de agregacié de dades, no es poden
obtenir directament des de les bases grafiques per la qual cosa s’han generat aquestes rutines.

Un dels aspectes més destacables de I'aplicacié generada es que a la funcionalitat basica de
qualsevol Sistema d'Informacid Geografica, de relacionar informacié grafica i informacié
alfanumérica i de generar vincles entre aquestes, en aquest cas es pot a més obtindre informacio
que no es directe de les entitats, com per exemple el sostre potencial de habitatge, etc.



3.2 SOFTWARE UTILITZAT

Per tal de desenvolupar el Prototip SIT-CAT 1.0 s’ha utilitzat el software ArcGIS - Arcinfo de
'empresa ESRI Inc., concretament s'utilitza la versié 9.2 Service Pack 2, doncs disposa de tres
moduls que superen les demandes basiques d’un SIG anteriorment citades.

Els tres moduls son:

ArcMap, és una aplicacio per I'entrada de dades, realitzar cerques especifiques i geografiques, i
la sortida mapes impresos.

ArcCatalog, és una eina per organitzar i documentar les dades geografiques.

ArcToolbox, grup deines que serveixen per realitzar geoprocessos com per exemple la
combinacié de capes d'informacid, transformacié de coordenades, calculs, entre daltres.

Per aquesta eleccié s’han considerat a més dues premisses basiques: la facilitat en la gestio
per 'usuari davant d'altres softwares i la versatilitat del format resultant dels arxius produits
amb ArcGis, els arxius shape (*.shp).

Respecte a la primera, cal ressaltar que ha estat la premissa que ha fet decantar, finalment,
I'elecci6 del software ArcGis. L'eina resultant fruit d’aquest projecte, el SIG Patrimonial
d'INCASOL, ha d'ésser una aplicacié utilitzada per una majoria de gent no experimentada com a
usuaria d’'un SIG. Per tant, és molt important que l'aplicacié sigui el més senzilla d'utilitzar i el
software utilitzat permeti aquesta caracteristica. Tenint en compte aquest aspecte, no hi ha cap
mena de dubte en qué ArcGis és el software més idoni front a GeoMedia, doncs I'arquitectura
d’aquest darrer implica establir connexions a la informacié necessaria, a vegades de logica
complexa, per visualitzar la informaci6 desitjada mentre que ArcGis només requereix buscar la
informacié on aquesta es troba emmagatzemada de forma identica que I'Explorador de Windows.
Es cert que un cop programada |'aplicacié aquests procediments inicials podrien ser parcialment
substituits, perd el manteniment posterior del SIG es trobaria amb aquest problema esmentat.
Per tant, podem concloure que a efectes de manteniment del SIG, la utilitzacié d’ArcGis seria
més senzilla, des del punt de vista tecnic, i més eficient, des del punt de vista temporal.

Per altra banda, la segona premissa també és important a efectes de la decisié presa tot i que no
té un paper tant determinant. Es tracta de la versatilitat del format resultant de treballar amb el
software ArcGis. Aquest software genera arxius shape, amb extensié *.shp, els quals
constitueixen el format d’intercanvi universal en el mon del SIG. Es a dir, un arxiu shape és
admes per qualsevol software SIG que hi ha actualment en el mercat. En canvi, el format grafic
resultant de GeoMedia és una base de dades Access, amb extensié *.mdb, la qual no és
acceptada per tots els software SIG.
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3.3 IMPORTACIO DE LA CARTOGRAFIA

La cartografia que ha estat proporcionada per INCASOL és de naturalesa CAD, normalment en
format DGN corresponent al software MicroStation i, en alguns casos, en format DWG
corresponent al software AutoCad.

Partint de la cartografia proporcionada per INCASOL s’ha importat al software ArcGIS 9.2
mitjangant I'eina Conversion Tools > To Geodatabase > Import from CAD.

El resultat d’aquesta informacio és la creacié d’'una Geodatabase (arxiu GDB) que conté:

Les entitats grafiques separades en feature datasets, segons si son poligons (frames, polilinies
tancades, circumferéncies), linees (linies, arcs, polilinies obertes) o punts (punts, textos).
Addicionalment també s'importa un feature dataset que s'anomena CadDoc i que es correspon amb
I'extensié del document CAD.

També s’importen unes taules que es corresponen a la informacié no geométrica extreta del CAD
(capes, colors, tipus de linia, entre d’altres).

Es vinculen les taules alfanumériques a les entitats grafiques mitjancant I'identificador tnic EntlD
i es seleccionen les que es volen importar a través dels seus atributs (per exemple, les de color
vermell de la capa sectors).

Durant el procés d'importacié es georeferencia la informacié provinent del CAD, en aquest cas
utilitzant el Sistema de Referéncia “European Datum 1950 UTM Zone 31N”, tenint en compte que
totes les propietats 'INCASOL sén a Catalunya.

3.4 DEPURACIO DE LA CARTOGRAFIA

Un cop realitzada la importacié de cada arxiu, cal executar 'ordre Data Management Tools >
Features > Check Geometry. En el cas que es produeixi algun error caldra executar Data
Management Tools > Features > Repair Geometry per a corregir-lo i evitar tenir geometries no
valides que poden generar errors, la més comuna de les quals és incorrect ring ordering. Aquest
error s produeix quan s'importen poligons els nodes dels quals estan numerats en ordre invers,
cosa que confon al programa pensant que son forats i els assigna una area negativa.

A continuacié cal comprovar que no hi hagi superposicions en la geometria importada, que
poden ser consequéncia d'entitats coincidents en l'arxiu de CAD o derrors en la rutina
d’importacio. Per aquest motiu es procedeix a crear una nova Feature Dataset amb ArcCatalog
(modul que incorpora ArcGIS 9.2) i s’hi copien les entitats importades. Seguidament es crea una
topologia amb l'ordre File > New > Topology i es tria que la regla que ha de complir-se sigui Must
Not Overlap, és a dir, que no hi hagi superposicions d’entitats. Posteriorment, al realitzar la
carrega d’'aquesta topologia a ArcMap (modul que incorpoora ArcGIS 9.2) queden diferenciats
els errors amb color vermell. Seguidament executem Layer Properties > Errors per tal de generar
un llistat dels errors trobats.

Si hi ha algun error en aquest llistat creat caldra que sigui depurada manualment la cartografia,
essent necessari en algunes ocasions netejar l'arxiu de CAD i tornar a realitzar el procés
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d'importacié altra vegada de les entitats, procés citat anteriorment (pagina 8). Es especialment
important evitar duplicitats de subsectors, sectors i poligons, utilitzant sempre la entitat més
petita de la qual es disposi informaci.

A continuacié s’assignaran manualment els atributs a les entitats importades, essent el més
importat el codi OBI que és el que permetra realitzar la vinculacié amb la base de dades existent.
Certes vegades el codi no apareix en els planols i caldra realitzar una investigacio en profunditat
tenint en compte diferents variables que apareixen en els llistats en paper que formen par de la
documentacié de partida.

Un cop assignat el codi OBI, degut a qué aquest pot representar propietats discontinues, sera
necessari executar 'ordre Data Management Tools > Generalization > Dissolve, fent servir el
camp del codi OBI per poder tenir totes les entitats amb el mateix codi com a una Unica entitat
multipart i, per tant, que participin en els calculs que facin servir I'area de manera conjunta.

3.5 ARQUITECTURA DE L’APLICACIO SIT - CAT 1.0

L’organitzacié de les capes grafiques adopta el model estructural que imposa el software utilitzat,
en aquest cas ArcGIS. Aquest model anomena cada capa grafica com una Feature Class, les
quals poden ésser agrupades en un Feature Dataset. Per sota el nivell de Feature Class
I'aplicacio6 crea capes d’informacié anomenades Subtype.

Imatge N° 2: Arquitectura basica de I'aplicacié SIT — CAT 1.0

CATALUNYA |
Faature Datasst

MUNICIPIS ¥
Feature Class

ks
ol

ELEMENTS
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Font: Elaboracié propia a partir d’ArcGIS 9.2
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A continuaci6 es detalla el llistat de taules desenvolupades amb informacié alfanumérica
associada, i no hem cregut necessari explicar els camps especifics de cadascuna que
s’expliquen en el document tecnic.

- Capa “MUNICIPIS”

- Capa “‘FINQUES”

- Capa “PLANEJAMENT”
- Capa “BASSES_POUS”
- Capa “EDIFICACIO”

- Capa “ARBRES”

- Capa “PEIN’

- Capa “VEDATS”

- Capa “ACA’

- Capa “PENDENTS’

3.5.1 Dominis creats per les taules alfanumeériques

Per alguns dels camps d'informacié existents s’ha cregut necessari crear dominis. Un domini
resulta ser una llista amb les diferents possibilitats de significat que pot tindre el camp
d’informacio.

D'aquesta manera l'usuari ha d’escollir de la llista un significat per aquell camp d’informacio,
limitant la possibilitat d'introduir significats que no sén valids i evitar la possibilitat de cometre
errades ortografiques en el moment de la introduccié manual de dades a la taula alfanumérica.

A continuacié es posa el llistat dels dominis creats per als diferents camps d’informacié:

Domini del camp d’informacié “Classe_Sol”

- Domini del camp d’informacié “Proindivis”

- Domini del camp d’informacié “Proindivis”

- Domini del camp d’informacié “Gesti6”

- omini del camp d’informacié “Inclou_elements
D del d’inf “Incl I ts”

- Domini del camp d’informacié “Instrument”

- Domini del camp d’informacié “Planejament”

- Domini del camp d’informaci6 “Poligon”

- Domini del camp d’informacié “Pous_Basses”

- Domini del camp d’informacié “Propietat”

- Domini del camp d’informacié “Qualificacio”
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Domini del camp d’informaci6 “Sit_Basica_Sol”
Domini del camp d’informacié “Tramitacié”

Domini del camp d’informacié “Proindivis”

3.6 LA PROGRAMACIO

Tot i utilitzar un software molt potent com és ArcGIS 9.2, el Prototipus SIT — CAT 1.0 ha de
respondre a diferents necessitats dels seus usuaris molt particulars, motiu pel qual es fa
imprescindible utilitzar la programacié. Amb aquesta programacié s’aconsegueix fer més a mida
l'aplicacid respecte a l'usuari, doncs podra realitzar calculs que impliquen operacions entre
diferents capes molt complexes clicant només un bot6. Aquest grup de calculs complexes s’han
agrupat sota el nom “Eines INCASOL”.

Per altra banda, també s’han realitzat altres treballs de personalitzacio de I'aplicacio. Aquests no
han suposat una feina de programacié tant exhaustiva com els anteriors, pero si responen a una
finalitat semblant. Aquest segon grup de personalitzacions de I'aplicacié s’han agrupat sota el
nom “Eines Addicionals”.

A continuacio6 s’explicara la finalitat de cadascuna de les Eines INCASOL, aixi com l'arquitectura
resultant de la programacio i el codi font que les descriu. Les eines han estat programades amb
el software Model Builder que incorpora el propi ArcGIS 9.2, no limitant la programacioé a un
llenguatge especific.

3.6.1 Eina Calcul

Aquesta eina permet calcular els metres quadrats de sostre maxim potencial d’Us industrial,
habitatge i comercial tenint en compte els parametres de cada sector que afecta cada finca; els
metres quadrats de sostre i percentatge minim destinat a habitatge protegit; i el nombre
d’habitatges maxim. Un cop finalitzats els processos que impliquen I'eina s’ha generat una nova
capa grafica, en la taula d’atributs de la qual hi ha els resultats dels calculs anteriorment
esmentats.

Imatge N° 3: Arquitectura Eina ICASOL “Calcul”

¥ ] ¥ ‘;5‘.1
M?)dul M?)dul Modul
Percent Habitatges Edificablitat

Percent Habitatges

Edificabilitat

Font: Elaboracié propia a partir d’ArcGIS 9.2
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En la imatge N° 3 pot apreciar-se I'arquitectura de I'eina “Calcul”, la qual esta formada per tres
moduls. Cada un d’aquests moduls realitza una série de passos i el resultat que obtenen és la
matéria prima del segiient modul, fins aconseguir el resultat final de I'edificabilitat.

A continuacié es creu necessari detallar cadascun dels tres moduls de qué es composa I'eina
“Calcul’: “Modul Percent”, “Modul Habitatges” i “Modul Edificabilitat”.

Imatge N° 4: Arquitectura del “Modul Percent”
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Font: Elaboracio propia a partir d’ArcGIS 9.2

En la imatge N° 4 es pot apreciar 'arquitectura del “Modul Percent”. Es representa en color
blau la capa grafica, en color groc els procediments, i en color verd els resultats. L'eina “Modul
Percent” parteix de la informacié de tres capes grafiques: planejament, finques i municipis.
Utilitza un algorisme que fragmenta les entitats de partida fins obtenir porcions homogénies en el
sentit que pertanyen a una sola finca, a un sol instrument de planejament i a un Unic municipi,
cosa que ens permetra després agregar aquesta informacié segons els criteris que ens
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interessin. Finalment, I'eina és capag de calcular el percentatge de superficie de sol de cadascun
dels fragments respecte la superficie total de l'instrument de planejament que I'afecta.

Imatge N° 5: Arquitectura del “Modul Habitatge”
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Font: Elaboracio6 propia a partir d'ArcGIS 9.2

En la imatge N° 5 es pot apreciar I'arquitectura del “Modul Habitatge”. Es representa en color
blau la capa grafica, en color groc els procediments, i en color verd els resultats. L'eina “Modul
Habitatge” calcula el nombre maxim d’habitatges a partir de la densitat bruta definida pel
planejament, o bé directament si el planejament ho defineix aixi.

També calcula el percentatge minim de sostre destinat a habitatges amb protecci6 oficial agafant
el valor maxim entre el que estableix la legislacio vigent, el planejament i 'acordat per conveni. A
partir de tots aquests calculs, 'eina assigna els valors corresponents segons el percentatge de
participacié dels fragments.
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Imatge N° 6: Arquitectura del “Modul Edificabilitat”

Crea Sup
HPO

Ediﬁc}::bililal
Comercial

%€Sup

HPO

Calg:; Edi
Com

Ediﬁc;;bililal
Habitatge

Calcﬂ Edi
Hab

Ediﬁl‘:}:biliwt
Industrial

(Calcul Edi Ind|

Neteja

Font: Elaboracio propia a partir d’ArcGIS 9.2

En la imatge N° 6 es pot apreciar I'arquitectura del “Modul Edificabilitat”. Es representa en
color blau la capa grafica, en color groc els procediments, i en color verd els resultats. L'eina
‘Modul Edificabilitat” calcula I'edificabilitat pels usos industrial, comercial i habitatge, a partir de
Iedificabilitat bruta i el percentatge per cada us.

Addicionalment, a partir del “Modul Habitatge” calcula el sostre minim d’habitatge protegit.

3.6.2 Eina Dissolve

Aquesta eina agrupa totes les porcions de les finques amb el mateix codi OBl en una sola entitat.

Imatge N° 7: Arquitectura Eina ICASOL “Dissolve”

#
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Font: Elaboracio6 propia a partir d’ArcGIS 9.2
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3.6.3 Eina Report (Access)

Aquesta eina prepara la informacié per ser tractada amb el software Crystal Reports ESRI
Edition, amb el qual es generaran les sortides d’impressio.

Imatge N° 8: Arquitectura de I'eina Report (Access)
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Font: Elaboracio6 propia a partir d’ArcGIS 9.2

En la imatge N° 8 es pot apreciar I'arquitectura de I'eina “Report Access”. Es representa en
color blau la capa grafica, en color groc els procediments, i en color verd els resultats.

A continuacié es creu necessari detallar el modul “Calcul Report”, doncs es tracta d’unes
operacions intermédies imprescindibles perqué lI'eina “Report Access” pugui aconseguir el
resultat final.

Imatge N° 9: Arquitectura del modul “Calcul Report”
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Font: Elaboracio propia a partir d’ArcGIS 9.2
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En la imatge N° 9 es pot apreciar I'arquitectura de I'eina “Report Access”. Es representa en
color groc els procediments, i en color verd els resultats. L’'eina “Calcul Report” automatitza tots
els processos necessaris (descrits anteriorment) perqué puguin ser tractades les dades amb el
Crystal Reports ESRI Edition.

S’han incorporat dues eines addicionals a I'aplicacié per tal de donar més potencialitat. Aquestes
eines son: “Export to KML” i “WMS Tool”. En tots dos casos s’ha optimitzat el seu funcionament
en funcié dels requeriments de l'usuari i també s’ha incorporat una icona per tal de poder-les fer
més accessibles.

3.6.2 Export to KML

Aquesta eina permet passar un arxiu creat amb ArcGIS, anomenat shape, a un arxiu de Google
Earth, anomenat KML o KMZ. Aquesta possibilitat oferida permetra a l'usuari compartir la
informaci6 que ha elaborat amb ArcGIS amb altres persones que disposin d’Internet per poder
utilitzar la plataforma de Google Earth.

Export to KML 2.5 és una extensi6 per a ArcGIS 9.2 desenvolupada per la Oficina de Planificacid
de la Ciutat de Portland, Estats Units. L'extensio permet que qualsevol punt, linia o poligon
puguin ser exportats com a detalls en 2D o, si adopta els valors d’un atribut com a algades, en
3D. També ofereix la capacitat d'incorporar la simbologia d’ArcGIS en I'etiquetatge d’exportacio
de KML (etiquetant punts, linies i poligons), aixi com descriure les caracteristiques principals dels
atributs de la base de dades i 'emmagatzematge dels atributs de la base de dades com articles
d’esquema.

Aquesta eina s'executa mitjangant una icona (el simbol de Google earth), la qual ha estat
introduida a la barra d’eines funcionals de la interficie de I'aplicacié SIT — CAT 1.0 mitjangant la
capacitat d'un arxiu tipus llibreria que permet incorporar una icona al menu Toolbars.

3.6.3 WMS Tool

Aquesta eina permet afegir o eliminar una nova connexié WMS amb I'aplicacié SIT — CAT 1.0, tot
i que préviament ja s’han parametritzat les connexions WMS necessaries pels usuaris de
I'aplicacio.

L’eina WMS Tool (Eina Sevidor de Mapes Web) s'uneix a un WMS extern i descarrega i
emmagatzema el contingut com una base de dades local. A més a més, permet modificar I'estil
amb qué és rebuda la imatge i permetent la definicié de la mida de la cel-la.

Les connexions preestablertes a I'aplicacié SIT — CAT 1.0 sén les segients:
- WMS Raster de I'Institut Cartografic de Catalunya (ICC): aquesta connexio permet visualitzar

per defecte I'ortofotoimatge a escala 1:5.000 de tota Catalunya, gracies al servidor Shagrat de
I'ICC al qual es pot accedir a través de http://shagrat.icc.es/lizardtech/iserv/ows?.

- WMS Cadastre: aquesta connexié permet visualitzar la cartografia cadastral de tota Espanya,
gracies al servidor al qual es pot accedir a traves de
http://ovc.catastro.meh.es/Cartografia/ WMS/ServidorWMS.aspx?. A més a més, aquesta
connexid permet visualitzar o no 13 elements grafics o text que aporten informaci6 addicional.
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- WMS PNOA: aquesta connexié permet visualitzar les ortofotoimatges del Plan Nacional de
Ortofotografia Aérea, gracies al servidor al qual es pot accedir a través de
http://www.idee.es/wms/PNOA/PNOA. De forma provisional, fins que la cobertura del PNOA sigui
completa, s’han inclos les ortofotoimatges del Projecte SIGPAC a Asturies i part de Galicia.

- WMS Mapa Base IDEE: aquesta connexié permet visualitzar la base cartografica numerica a
escales 1:25.000 i 1:200.000 del Instituto Geografico Nacional, gracies al servidor al qual es pot
accedir a través de http://www.idee.es/wms/IDEE-Base/IDEE-Base.

- WMS Cartociudad: aquesta connexié permet visualitzar la base de dades oficial de la xarxa
viaria d’ambit nacional amb estructura topologica de SIG que permet la navegacid per tot el
territori espanyol. A més a més, conté el parcel-lari cadastral i la divisio en poligons dels
districtes censals i postals. Es pot gaudir d’aquest servei gracies al servidor al qual es pot accedir
a través de http://www.cartociudad.es/wms/CARTOCIUDAD/CARTOCIUDAD.

- WMS Ocupaci6 del Sol: aquesta connexié permet obtindre informacié de I'ocupacio del sol a
Espanya en els anys 1990 i 2000, i els canvis en 'ocupacio durant aquesta década, a partir de
les dades del Projecte Corine Land Cover. Es pot gaudir d’aquest servei gracies al servidor al
qual es pot accedir a través de http://www.idee.es/wms/IGN-Corine/IGN-Corine.

4. PROTOTIPUS SIT - CAT 1.0

4.1 FUNCIONALITATS BASIQUES DE L’APLICACIO

En aquest apartat es descriuen les eines principals que hi ha en la interficie grafica de I'aplicacid,
les quals permeten a un usuari no avangat poder visualitzar la informacid i realitzar algunes de
les funcionalitats basiques que ofereix la citada aplicacio.

4.1.1 Descripci6 de la interficie grafica d’'usuari

La interficie grafica d’'usuari, en el context persona-ordenador, és I'artefacte tecnoldgic d’un
sistema interactiu que fa possible, a través de I'is i la representacié del llenguatge visual, una
accié amigable amb un sistema informatic. Normalment les accions es realitzen mitjangant la
manipulacié directa per facilitar la interaccié de l'usuari amb la computadora. Un exemple
d'interficie grafica d'usuari és I'escriptori (0 desktop) del sistema operatiu Windows.
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Imatge N° 10: Interficie grafica d’usuari del SIT — CAT 1.0
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Font: Elaboraci¢ propia a partir d'ArcGIS 9.2

En la imatge N° 10, que correspon a la interficie d’'usuari de I'aplicacié SIT — CAT 1.0, es poden
diferenciar tres components basiques:

- A la part superior apareixen els menis on hi ha les eines basiques d’'un SIG, que seran
explicades amb detall en el segiient apartat.

- Alesquerra hi ha una finestra en la que es poden visualitzar les diferents capes d’informacio
cartografica de qué disposa I'aplicacié. Clicant el quadrat petit que cada capa té es fa visible o no
aquesta, i com que es tracta d’una estructura de capes podrem visualitzar-les totes a la vegada.
Si cliquem al simbol + que té cada capa visualitzarem les entitats que conté aquesta capa i la
seva representacio a la finestra de mapa sera del color que es mostra.

- Laresta de la interficie correspon a la finestra de mapa, en la qual es visualitzaran les capes
d'informacié escollides. Hi ha dues barres de desplagament a la part inferior i dreta, quatre
icones que podem trobar en els menus d’eines amb funcionalitats basiques i un rectangle a la
part inferior dreta on es mostren les coordenades X,Y. Cal destacar que a la coordenada X li falta
el primer digit que és el 4.
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4.1.2 Descripci6 de les eines basiques
En aquest apartat es vol explicar en detall les eines existents en els menus que hi ha a la part

superior de la interficie de I'aplicacio, anteriorment esmentats. Només son explicades aquelles
funcionalitats que seran podran ser utilitzades pels usuaris de I'aplicacio.

Imatge N° 11: Menus d’eines amb funcionalitats basiques
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Font: Elaboracio propia a partir d’ArcGIS 9.2

- Exportar Mapa: Aquesta funcionalitat permet crear un arxiu de tipus imatge de la finestra de
mapa tal com esta en el moment que s'executa. Per utilitzar-la cal clicar File del menu superior,
es desplega un altre menu on cal clicar Export Map... i s'obre una finestra en la qual caldra
nombrar l'arxiu de tipus imatge creat i escollir 'extensié d’aquest, aixi com si es vol es poden
modificar les opcions de resolucié o les dimensions de la imatge, entre d'altres. Aquesta
funcionalitat ens permetra intercanviar imatges via correu electronic o intranet.

- Accés al Llistat d’actuacions: Aquesta funcionalitat permet escollir una actuacié determinada i
situar-la en la finestra de mapa. Per utilitzar-la cal clicar View del menu superior, es desplega un
altre menu on cal clicar a Bookmarks i, finalment, es desplega un submenu amb el llistat dels
ambits d’actuacié disponibles en l'actualitat. Clicant I'ambit desitjat es situara a la finestra de
mapa. Aquesta funcionalitat ens permet cercar i situar-nos de forma rapida en I'ambit d’actuacio
escollit.

- Seleccio per Atributs: Aquesta funcionalitat sera explicada més endavant, tot i estar present en
el menu superior es tracta d’'una funcionalitat avancgada.

- Seleccié per Localitzacio: Aquesta funcionalitat sera explicada més endavant, tot i estar
present en el menu superior es tracta d’'una funcionalitat avangada.

4.2 FUNCIONALITATS AVANGADES DE L’APLICACIO

En aquest apartat s’expliquen algunes de les funcionalitats avangades que pot realitzar I'aplicacid
SIT - CAT 1.0 i que tinguin un cert interés pels usuaris a qué esta destinada. Tenint aquest criteri
en compte, es tractaran les funcionalitats que impliquen seleccions per atributs i seleccions per
localitzacio, consultes a la base alfanumérica de les entitats grafiques, el grup d’eines INCASOL i
altres eines addicionals incorporades com la utilitzacio de servidors de mapes externs i la
possibilitat de compartir informacio a partir de la plataforma Google Earth.
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4.2.1 Seleccio per atributs

Aquesta funcionalitat avancada permet crear una seleccié d’entitats imposant una serie de
criteris alfanumérics. En I'exemple es vol saber quantes finques hi ha en el municipi

d’Esparraguera.

Imatge N° 12: Selecci6 per atributs de les finques existents al municipi d’Esparraguera
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Font: Elaboracio propia a partir d’ArcGIS 9.2

4.2.2 Seleccio per localitzacio

Aquesta funcionalitat avangada permet crear una seleccié d’entitats utilitzant el creuament de
dues capes grafiques. En I'exemple seglent es vol saber quantes finques hi ha en el municipi

d’Aiguaviva.
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Imatge N° 13: Seleccié per localitzacio de les finques existents al municipi d’Aiguaviva
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4.2.3 Consultes a la base alfanumérica de les entitats grafiques

A nivell alfanumeric 'aplicacié SIT — CAT 1.0 permet realitzar consultes predeterminades per
cada una de les capes grafiques disponibles a la finestra esquerra de I'aplicacio.

Per tal d'accedir a la taula alfanumérica cal clicar amb el boté dret del ratoli sobre la capa i
escollir 'opcié Open Attribute Table, procediment explicat anteriorment (pagina 18).

Oberta la taula alfanumérica on hi ha els atributs de I'entitat grafica corresponent, cal clicar el

botd Options (situat a la part inferior dreta de la taula alfanumérica) per poder accedir al menu de
funcionalitats.
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Imatge N°14: Funcionalitats de la taula alfanumérica de les entitats grafiques
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Font: Elaboracio propia a partir d’ArcGIS 9.2

4.2.4 Menu contextual de les capes grafiques

Es tracta d'un conjunt de funcionalitats existents per cascuna de les capes grafiques vectorials
disponibles en I'aplicacié SIT — CAT 1.0, les quals son accessibles clicant amb el bot6 dret del
ratoli sobre el nom de la capa grafica:

4.2.5 Propietats de les capes grafiques

Es tracta d’un conjunt de funcionalitats molt complet que permet tindre un exhaustiu control d'un
gran nombre de possibilitats que ofereix aquest grup de funcionalitats. Per accedir-hi cal clicar
amb el botd dret del ratoli sobre el nom de la capa grafica i clicar sobre la icona anomenada
Properties... (“Propietats”). S'obrira la seguent finestra:

4.2.6 Elaboracié de mapes tematics

Un mapa tematic representa la distribucié espacial d’'un fenomen mitjangant trames o diferents
tons de color o gris en la que la gradacio d'intensitat expressa diferents intervals d’'un fenomen
en unitats territorials, administratives o convencionals.

En el SIG, també és utilitzada aquesta técnica de representacio cartografica per representar el
valor d'un atribut dels elements d’'una capa grafica de forma continua en I'espai. Es habitual
representar variables com la poblacid, els valors economics (per exemple el PIB per capita o els
preus dels habitatges) o variables socials, entre d’altres.
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Per tal de generar amb I'aplicacié SIT — CAT 1.0 un mapa tematic cal accedir al menu de
propietats de les capes grafiques, procediment explicat anteriorment (pagina 23). Cal escollir
l'opcié Symbology (“Simbologia”) i apareixera la seglient finestra:

En la imatge n°8 s’observa que es poden escollir cinc formes de visualitzacio, tot i que la primera
no és un mapa tematic doncs només tracta la visualitzacio de les entitats. Per tant, els quatre
tipus de realitzar un mapa tematic sén: per categories (Categories), per quantitat (Quantities), per
grafics (Charts) i per atributs multiples (Multiple Attributes). L'opcid que s'utilitza més
comunament és el mapa tematic per categories representant un unic valor, el qual ens permetra
visualitzar a la finestra de mapa, per exemple, quines finques sé6n de propietat i quines no ho
son. A continuacié s'explica el procediment per realitzar aquest funcionalitat avangada:

Imatge N°15: Mapa tematic de finques en propietat d'INCASOL
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Font: Elaboracio6 propia a partir d’ArcGIS 9.2

En la imatge N° 15, I"actuacio de Mas d’en Blai — Castillejos, es pot comprovar que totes les
finques existents son propietat d'INCASOL.

4.2.7 Eines addicionals incorporades a I’aplicacié SIT - CAT 1.0

S’han incorporat dues eines addicionals a I'aplicacié per tal de donar més potencialitat. Aquestes
eines soén: “Export to KML” i “WMS Tool”. En tots dos casos s’ha optimitzat el seu funcionament
en funcié dels requeriments de l'usuari i també s’ha incorporat una icona per tal de poder-les fer
més accessibles.
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Eina: Export to KML

Aquesta funcionalitat permet passar un arxiu creat amb ArcGIS, anomenat shape, a un arxiu de
Google Earth, anomenat KML o0 KMZ. Aquesta possibilitat oferida permetra a 'usuari compartir la
informacié que ha elaborat amb ArcGIS amb altres persones que disposin d’Internet per poder
utilitzar la plataforma de Google Earth.

Imatge N° 16: Procediment d’exportacié de dades
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Font: Elaboracio propia a partir d’ArcGIS 9.2

Eina: WMS Tool

Aquesta eina permet vincular un Servidor de Mapes Web a I'aplicacié SIT — Cat 1.0, funcionalitat
que permet disposar de cartografia sens tindre-la fisicament a la maquina on s’esta treballant. La
cartografia és rebuda com una imatge (format png) i, per tant, no podra ser utilitzada pel SIG per
realitzar analisis doncs no es tracta d'informaci6 vectorial, perd permet tindre de fons aquesta
imatge com una capa més i poder prendre gran quantitat de decisions gracies a aquest fet.

Es tracta d'una funcionalitat avangada i per aquest motiu ja s’han incorporat els Servidors de
Mapes que tenen interés pels usuaris de I'aplicacio.

4.2.8 Eines avangades desenvolupades especificament per I'aplicacié SIT - CAT 1.0

S’han desenvolupat un grup d’eines especifiques per aquesta aplicacié utilitzant les capacitats

del modul ArcToolbox, un dels tres que es troben inclosos en ArcGIS 9.2, i s’han agrupat amb el
nom d’eines INCASOL. Cada una d’aquestes eines respon funcionalitats especifiques que son
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d'interés per l'usuari de I'aplicacio. Les eines han estat programades amb el software Model
Builder que incorpora el propi ArcGIS 9.2

Imatge N° 17: Eines INCASOL
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Font: Elaboracié propia a partir d’ArcGIS 9.2

Es tracta del grup d’eines especialment programades pels usuaris de l'aplicacié que ha estat
anomenat “INCASOL". Es tracta del submenu d’eines INCASOL anomenat “Intermig”. Aquest
conté diferents procediments que realitzen calculs diversos:

- Calcul: Aquesta eina permet calcular els metres quadrats de sostre maxim potencial d'Us
industrial, habitatge i comercial tenint en compte els parametres de cada sector que afecta cada
finca; els metres quadrats de sostre i percentatge minim destinat a habitatge protegit; i el nombre
d’habitatges maxim.

- Dissolve (OBI): Eina que es va desenvolupar, perd en proves en la versié 1.0 de I'aplicacié. En
futures versions estara disponible totalment pels usuaris.

- Report (Access): Aquesta eina genera les mateixes operacions que I'eina “Calcul’ i, a més a
més, prepara la base de dades resultant perqué pugui ser visualitzada correctament a 'eina de
generacio d'informes Crystal Reports Bussines Objects, la utilitat de la qual sera explicada en el
seguent apartat.

- Report (dbase): Aquesta eina genera les mateixes operacions que I'eina “Calcul” i, a més a
més, prepara la base de dades resultant perqué pugui ser visualitzada correctament per la gran

majoria de gestors de bases de dades i fulles de calcul, com per exemple Microsoft Access i
Microsoft Excel.

4.3 GENERACIO DE SORTIDES D’'IMPRESSIO

4.3.1 Lafitxa

L'aplicacié6 SIT — CAT 1.0 permet realitzar, mitjangant la vinculaci6 amb el software Crystal
Reports ESRI Edlition, una série de sortides impreses a partir de les necessitats de I'usari.
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S’han programat dues sortides:

- Fitxa de la finca: en un format A3 horitzontal es mostra els limits de la finca sobreposada a
l'ortofotimatge a escala 1:5.000 de I'Institut Cartografic de Catalunya i a la cartografia cadastral.
També s’ha preparat I'opci6 que hi aparegui una fotografia de I'emplagament. A nivell
alfanumeéric, apareixen dades que corresponen a la finca, dades dels elements continguts en
ella, i dades corresponents al potencial urbanistic que li correspon segons les figures de
planejament que I'afecten.

Imatge N° 18: Exemple de la “Fitxa de la finca”

N
3 FITXA FINCA OBI

ZA INCASOL
del Sol Data informe: 16/07/2009 20:17:43

ORTOFOTO (ICC) CARTOGRAFIA CADASTRAL POTENCIAL URBANISTIC

y?r # m Vo L8) Sostre potencial habitatge: 85.028,29 m*

s > 3 & . Sostre potencial HPO: 28.922,70 m*

: & Habitatges potencials: 1082 Hab
Sostre potencial industrial: 0,00 m*
Sostre potencial comercial: 0,00 m*
FOTOGRAFIES

ESTAT DE LA PROPIETAT

Propietat: SI
Proindivis: NO
Percentatge proindivis: 100,00%

CONSTRUCCIONS | ALTRES
Inclou edificacio: Desconeaqut
Estat edificacio:

Inclou altres construccions:
Inclou pous:

Inclou basses:

Inclou arbres:

Inclou plantacions:

XX XXX

Notes.

DADES D'ALTA PATRIMONIAL
Data alta:

Document alta:

Valor alta:

DADES D'OCUPACIO

Té llogaters: XX
Data inici contracte lloguer:

Data final contracte lloguer:

Data preavis llogaters:

Temps preavis llogaters:

Indemnitzaci6 llogaters:

Descripcid de faccés

Font: Elaboraci¢ propia a partir d’ArcGIS 9.2 (Crystal Reports).

DADES DE BAIXA PATRIMONIAL
Data baixa:

Document baixa:

Procés baixa:

ALTRES DADES
Superficie amidament:
Us predominant:
Situacio basica del sol:
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Imatge N° 19: Exemple del “Resum del potencial urbanistic”

w. N RESUM DE POTENCIAL URBANISTIC
INCASOL
A institgt Catala
del Sol
Bages 0 0,00 m 000m: 1718027 m 0,00 m?
Castsllgau o 0,00 m* 0,00 m* 167.036,43 m* 0,00 m*
946 167.036,30 m*
Sant Viceng de Castellet 0 0,00 m? 0,00 m* 4.766,54 m* 0,00 m*
946 4.766,54 m*
Baix Ebre 0 0,00 m: 0,00m* 11033155 m* 0,00 m?
Aldea (I') 0 0,00 m? 0,00 m* 110.331,55 m* 0,00 m*
1.427 15,65 m?
1.428 415,99 m?*
1.429 5.035,27 m?
1.430 9.143,85 m?
1.431 7.554,7¢ m?
5028 1.611,56 m?
5.029 2.190,60 m*
5.070 7.990,50 m?*
5.099 2.307,23 m?
5401 2.988,71m*
5.403 8.743,01 m*
5415 1.632,44 m?
5.446 414592 m?
6.464 4.401,68 m?*
Baix Llobregat 1312 102.826,15m* 34,684,790 m* 0,00 m* 0,00 m*
Esparreguera 221 17.073,87 m* 5.759,86 m* 0,00 m* 0,00 m*
5.806 221 17.073,87 m* 5.759,86 m*
Sant Boi de Llobregat 32 2.497,90 m* 26,47 m? 0,00 m? 0,00 m*
6819 32 2.497,90 m* 2647 m?*
Santa Coloma de Cervelld 1059 83.254,39 m?* 28.898,45 m? 0,00 m? 0,00 m*
2252 9 72399 m* 222m?
6.619 1.050 82.530,40 m* 28.896,23 m*
Montsia 135 11.322,53 m* 1.083,98 m?* 2.407,89 m* 0,00 m*
14/07/2009 14:46:44 Pagina 1 de 2

Font: Elaboracié propia a partir d’ArcGIS 9.2 (Crystal Reports).

En aquest punt és important emfatitzar que 'aplicacié generada té una valuosa incidéncia en
I'estructura d’organitzacio i consulta dels dades relatius als bens patrimonials de I'Incasol, aixi
com en la planificacié de tasques futures a desenvolupar. Aquesta possibilitat ve donada per les
possibilitats que donen les eines SIG, a efectes de gestio i explotacio de dades territorials, que
finalment permeten la millora del procediment d’entrada i manteniment de dades amb una
important capacitat verificacié i per altra banda compartir informacié existent amb entitats
internes i externes i facilitar la cerca o consulta d’informacid.

S'ha fet un esforg important per entendre I'estructura de funcionament i del recorregut intern dels

dades dins de I'Institut per tal de generar una aplicacié Util per I'iis de patrimoni, perd que també
pugui ser d'utilitat futura per altres departaments i institucions.
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En aquest sentit es fa émfasi el la programacié d’eines especifiques, questié que no s’havia
contemplat en la proposta, eines que seran de molta utilitat a efectes de coneixer qgliestions
relatives amb els potencials de aprofitament, com 'eina calcul, que permetra calcular els m2 de
sostre maxim potencial d’us industrial, d’habitatge i de comercial, dissolve, que agrupa totes les
porcions de les finques amb el mateix codi OBI en una sola entitat, report (access), que prepara
la informacié per ser tractada amb el software Crystal Reports ESRI Edition, amb el qual es
generaran les sortides d'impressié i altres com export to kml, 0 wms tool: Aquesta eina permet
afegir o eliminar una nova connexié WMS a I'aplicacio.

Finalment es important dir que I'aplicacié desenvolupada te un gran potencial d’aplicacié futura
en tres aspectes fonamentals:

En lo referent a la configuracié i personalitzacié del visor propi de I'lncasol es podria
Incorporar mes capes d'informacié, noves connexions com per exemple el registre de
planejament i la creaci6 d'un historic de 'evolucié del patrimoni.

Pel que fa referéncia a la determinacio, carrega de continguts i definicié de consultes es pot
estructurar un conjunt de rutines d’explotacié complexa de molts camps d’informacio, realitzar
estudis de prospectiva i avaluar escenaris diferents, crear mesures a mida, fer el seguiment de la
transformacio6 del sl i realitzar informes exhaustius ajustats a quiestions complexes.

En els aspectes relacionats amb les sortides de dades i I'actualitzacié de dades, existeix la
possibilitat de compartir informacié en formats estandarditzats, servidors de mapes via web,
captura d'informaci6 sobre el terreny (PDA) mobils, etc.

Finalment creiem que I'aplicacié desenvolupada es especialment important per 'INCASOL en el

sentit que permet diverses formes de veure la informacié actual i de fer consultes especifiques
de manera rapida que abans no es podien obtindre de forma facil.
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